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1. What is MATLAB ?

MATLAB started as an interactive program for doing matrix calculations and has
now grown to a high level mathematical language that can solve integrals and
differential equations numerically and plot a wide variety of two and three
dimensional graphs.

In this subject you will mostly use it interactively like a super-calculator. You will
also create MATLAB scripts that carry out a sequence of commands. MATLAB also
contains a programming language that is rather like Pascal.

The first version of Matlab was produced in the mid 1970s as a teaching tool. The
vastly expanded Matlab is now used for mathematical calculations and simulation in
companies and government labs ranging from aerospace, car design, signal analysis
through to instrument control & financial analysis. Other similar programs are
Mathematica and Maple. Mathematica is somewhat better at symbolic calculations
but is slower at large numerical calculations.

Recent versions of Matlab also include much of the Maple symbolic calculation
program.
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2 How to get started

When the computer has started go through the following steps in the different menus

e Look for the Network Applications folder and double click on that
e Within this you will see a little icon for Matlab61 — double click on that

Within about 30 seconds Matlab will open (you may get a little message box about
ICA applications — just click OK on this)

You should now see a screen like the picture below

<) MATLAB =1 ES
File Edit Yiew ‘Web Windew Help
OE| 8 B v o | ] | % | current birectary: [ CrMATLABEpT work =l -
Wor kspace EE Command YWindow .
= Stadk: |Elase =
- E m | ﬁ To get started, select "MATLAE Help™ from the Help menu.
Name | Jize I
>> |
1 I i

T

q |

Ready

This is the default Matlab screen — it broken into 3 parts

On the right you have the Command Window - this is where you type commands
and usually the answers (or error messages) appear here too

On the top left you have the Workspace window — if you define new quantities
(called variables) their names should be listed here.

On the bottom left you have Command History window - this is where past

commands are listed. If you want to re-run a previous command or to edit it you can
drag it from this window to the command window to re-run it.
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2.1 The Matlab promptis >>.

Look at the Command Window and you will see the cursor flickering after the >>
prompt. This means that Matlab is waiting for further instructions.

Command Window .EJJEJ

Y

To get started, select "MATLAE Help™ from the Help menu.

»r

2.2  Seeing the Matlab demo.

Just type the command
>> demo (and then press Enter or Return key)
and run the simple slideshow under the Matrix manipulation option.

This briefly shows you some of the things that Matlab can do - don’t worry if you do
not know what everything means here.
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2.3  Simple arithmetic with Matlab

The basic arithmetic operators are +, -, * (for multiplication), / (for divide) & * for
powers. Where necessary brackets should be used to make the order in which things
are evaluated completely clear.

Enter the following commands to learn the basic way that formulas can be evaluated in
Matlab (press enter after you have typed in the command. Record the answer beside
the command.

>> S O T

The result of this calculation is stored in the temporary variable called ans.
It is changed when you do another calculation.

If you want to save the answer from a calculation you can give it a name e.g.
S> BT 357

This line creates a variable t to save the answer in. If you want to find out what t is use

>> t

Equally you can use t in a formula

>> 2*t+ 2
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2.4 Correcting typing mistakes in Matlab

Sometimes you will make a mistake when you type a command into Matlab.
Sometimes Matlab will detect the error and give a warning. Then you need to type in
command correctly. Matlab provides a way to quickly edit the mistake using the up
arrow key T
On most keyboards the T key is in a group with the left and right arrows < and —
Example:
Suppose that you want to calculate sin(r)
The correct command is

>> sin(pi) [pi stands for = in Matlab]
Now make a deliberate error

>>  sib(pi)

Matlab recognizes that sib is not a built-in function

>> sib(pi)
??? Undefined function or variable 'sib".

Press the up-arrow key T and the last command re-appears
>>  sib(pi)
Now use the left and right arrow key or just click beside the b and change it to sin(3)

>> sin(pi) < this is the correct command
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2.4 The order of operations and putting brackets in can matter

In the following calculation does Matlab do the * or the " first ?
>> 3N2*4
To find this out think about the two possible options

e One way to do the calculation is that powers are done before multiplication.
This 32*4 = ..o,

e The other option is to do the multiplication first is 324 _ B i,

In this case you should have obtained the answer 36.

Matlab interprets 372*4 as 3% * 4 - it does 3”2 first and then multiplies the answer
by 4. Generally powers are done first, then multiplication and division and finally
additions and subtractions.

One way to force Matlab (or any software) to do calculations in a defined order is to
use brackets.

Compare the following commands and make sure that you understand what is
happening and why you get the answer

5> B MA-2 o I3 = % 2]
55 BAYA2) oo [%]
55> BBYA-2 e [% 2]

The rules for evaluating expressions involving numbers are
e things inside brackets are done first

e within a bracket or expression generally powers (*) are done first, then
multiplications and divisions and finally additions and subtractions.
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2.5 Extended arithmetic (IEEE)

You need to understand the following section to interpret the output from some calculations —
particularly when we make accidental errors.

What does Matlab produce if you ask it to find:

>> 10
>> S0

>> 0/0 e —————

>> LINT

The symbols Inf (meaning infinity) and NaN (not a well defined number) are part of a special
standard for computer arithmetic. This is the IEEE international standard for extended
arithmetic.

Typically you get Inf from 1/0 and NaN from 0/0 type calculations.

While Inf and NaN are usually signs that we have setup our problem incorrectly, Matlab will try
to manipulate these results consistently

For example extended arithmetic will ensure that 1/( 1/x) always equals x.

Test this out by asking Matlab to calculate

>> 1/(1/0)

Matlab can also handle complex numbers — they are entered as 1 +1i or -1+3*i etc

The symbol i is best kept as a reserved symbol (Matlab also interprets j as a complex number to
fit in with usage in electrical engineering)
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2.6 Matlab works to 15 significant figures but usually only shows 5
figures

Type pi in Matlab and you will normally get 3.1416
>> pi

To see all 15 figures you can change to the long format in which all 15 figures are displayed
To 20 figures t = 3.14159 26535 89793 23846

>> format long

>> Pl e

An easier and more flexible format is scientific notation with 5 significant figures

>> format short e

>> Pl e te e r e rn
Mostly we work in the short format.
To go back to short format

>> formatshort ...........ocooiiiiiiiii

Exponential format is particularly useful for very large or very small numbers- e.g.
6.00e+23 = 6*10%°.  Another format is format long e.
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2.7 The consequences of finite accuracy on a computer

Matlab only has limited accuracy (although it is more than enough for most uses)

Computers are normally set up to store numbers in a fixed amount of memory
Matlab uses 64 bits and this lets it store numbers as large as 2*103% or as small as

2*1073%8  But no matter which number you work with Matlab can only store it to
15 significant figures

For example:
Matlab could handle 1.234 567 890 234 56 (fifteen figures)
But a 20 digit number like 1. 234 567 890 234 567 890 12 is truncated to 15 figures.
This is an example of a round-off. Other cases of round-off occur if you add or
multiply two 15 figure numbers and then only store the first 15 significant figures of
the answer. Round-off cannot be avoided in computer calculations.
This type of unavoidable “error’ can affect the answers you get
What is the exact value of SIN(TT) ...oovvniniii i
What does Matlab gives for

>>  sin(pi)

Matlab uses a high order polynomial to approximate sin(x). This has a very slight
roundoff error that give a very small non-zero answer instead of exactly zero

Interpreting very small answers
Sometimes a answer that really ought to be exactly zero might appear as a small

number like 10715,

2.8 Variable names:

Matlab distinguishes between lower case and capital letters - so A and a are
different objects for Matlab. The normal convention to use lower case names
except for global variables. Only the first 19 characters in a variable name are
important.
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3. Matlab has many built in functions

Among them are:

Trig functions sin, cos, tan, sec, cosec and cotan
(sin(x) etc assumes that x is in radians)

Are the following what you expect ?
>> SIN(PI/2) e
>> COS(PI/2)
Remember that pi is a built-in constant

Inverse trig functions asin, acos, atan

(these are abbreviations for arcsin, arccos and arctan - the answers are returned in
radians so that, for example, asin(1) = pi/2)

Exponential functionexp
To calculate € we must use exp(5). The command e”5 will not work.

Logarithm functions log is log to base e, while
log10 and log?2 are logs to bases 10 or 2

Hyperbolic functionscosh, sinh, and tanh
Matlab also has many other more sophisticated functions for solving linear
equations, getting eigenvalues of matrices, solving differential equations or

calculating integrals numerically.

To find out what a built-in function does you can use the help command

Example: Use help to find out about the sin function
>> help log
LOG Natural logarithm. < Matlab name
LOG(X) is the natural logarithm of the elements of X. < Brief explanation
Complex results are produced if X is not positive. < More information
See also LOG2, LOG10, EXP, LOGM. < related functions
Overloaded methods:  help sym/log.m < another use of log
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4. Vectors and matrices in Matlab

Matlab is often used to work with matrices and vectors. Vectors are either row
vectors or column vectors and it is usually important to be clear as to what kind of

vector you mean.

Row vectors have one row and several columns like [4 7 10]

4
Column vectors have several rows in one column like | 7
10

The main use of matrices and vectors is in solving sets of linear equations:

The equations 2x+6y+3z =5
X+8y+ z =7
X +5y+3z =2

can be re-written in matrix/vector form as

2 6 3| x
3 8 1|y|=
1 5 3|z

N N O

Here the vectors are column vectors . The matrix contains the coefficients from the

equations.
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4.1 Entering row vectors

To enter the row vector v = [1 2 3 4] into Matlab use the command

>> v=[1, 2, 3, 4]

The square brackets are essential in Matlab when defining an array.
To check this see what Matlab has stored as v

>> v

You can leave out the commas and simply put in a few spaces between different
entries.

>> VYR 3 - X1 O

4.2  Entering column vectors
3
Column vectors are like the ones that appear on the RHS of aset -e.g. | 4
1.2
This is a matrix with just one column and 3 rows.

To create this column vector in Matlab you must mark the end of a row with
a semi-colon ;

>> a=[3; 4; 12]
The semi-colons are essential here.
If you leave out the semicolons what will you get ?

>> b=[3412] oo
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4.3 What variables have you defined already ?

Now look across at the Workspace window and you should see something like the
picture below _ you may need to expand this window a bit to see everything

<) MATLAB M=l 3

Eile Edit Wiew ‘Web ‘Windmw Help

O = | & B v oo | . | 9 |Currer|1 Directnry:ID:WmatIabRUIwork j J
Workspace A x|
= ‘ =] ‘ By stac B ]

Name aize Eytez|Clazs

@a axl 2d|double array

@ans 1xl g|double array

@h 1x3 2d|double array

@t 1xl g|double array

@v 1xd 3Z|double array

4 | ; | Launch Pad Yiorkspace I

This gives the name of the variable — its size as an array (1 x 1 is a single number).
You can also see the content of an array by double clicking on the yellow box beside
its name.

For example double clicking on b above gives

1 1 1 - D x
File Edt “iew ‘Web ‘Window Help

Numericfnrmatlshnne vl | size: |1 by |3 x|

1 2 3 «—— column numbers
1 1 4 lz| =— entries in array

Truw numhers

When you open the array editor you can see
the entries in the array - for large arrays
you can scroll up/dowm and left/right

If you want to keep in the command window you can just do whos and it prints a table
like the window above.
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4.4  Creating matrices

To define a matrix we use the symbol ; to indicate the end of row.

[op N S \S]

1
Try the following to create the matrix p= |3
5

>> P=[12; 34 ;5 6] e

What output does this produce — how many rows & columns does it define:

Now repeat the definition of p but make the deliberate mistake
>> p=[12 3;3 4;5 6]

Output:

This is an example of a Matlab error message.

Do you understand the error here ?

Now check that this mistake has not altered the value of p:

>> P

Matlab introduction
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45 Selecting numbers, rows and columns for a matrix

[op IR SN \V)

1
The matrix p that was just defined is |3
5

Try the commands and comment on what they select:

T - ) TSSO

>>  p(2,1)

T (25D N
S T N

Now use the information that you can get from these examples to write down the
commands that will select. Check out your command to make sure that it gives the
correct answer.

the number in the 3rd row, 2nd column of p ..o,

e the number in the 1strow, 2nd column of p .o

o the fiIrSt rOW frOM P oooeeiiiec e

o the third rOW frOM P eooeiiiiecc e

o the first cOlUMN frOM P .ooviieieee e

o the third coOlUMN frOM P .ooovvieic s
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5 Defining some common matrices and vectors

This section explains some special commands that will quickly create some simple
vectors and matrices.

5.1 Vectors and matrices of zeros

To create a row vector containing 4 zeros check that the following command works
>> r = zeros (1, 4)

What does the following command do
>> r =zeros(4,1)

Based on these two examples how would you create a matrix of zeros with 3 rows
and 4 columns

>>

5.2 Constant vectors

What do the following commands give
>> ones(1, 3)
>> ONES(1,0) e
>> ONES(2,d) i
>> 3*ones(1,3)
Can you find the Matlab commands to produce the following vectors or matrices

(1) a=[L111]

i) b

Il
W w w
w w w

Matlab introduction ) 17



5.3 Evenly spaced vectors

Examples of evenly spaced vectorsare [1,2,3], [3,7,11,15,19,23] and
[-3,0,3,6,9]

The most common place to use this type of vector is when we want to plot a graph.

Matlab gives us two ways to produce evenly spaced vectors:

(i)

(i)

The linspace command - we must specify the first and last numbers and

the number of entries

The colon method - here we must specify the first number, the gap
between the numbers and the last number.

Both ways are useful in different situations but probably the linspace method is most
widely used.

Here are the ways to get the three examples

(i)

(i)

a=[123]
>> a =linspace( 1, 3, 3)

[Explanation: 1 = the first entry, 3 = last entry, 3 = the number of
entries]

>>a=1:1:3 < Dbe careful to use colon symbol :

[Explanation 1 = the first entry, 1 = the gap between entries, 3 = last
entry]

b=1[37,1115,19, 23]
>> b = linspace( 3, 23, 6)

>> b= 3:4:23

What are the two ways to get

There are two ways to produce ¢c=[-3,0,3,6,9]

>>

>>

Matlab introduction
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6 Basic matrix operations

The symbols for matrix addition, subtraction, multiplication and powers are +, -, *
and ~

If a is a square matrix then a2 means a*a - the matrix product of a with itself.

Define the following matrices and see what happens with the matrix commands
(see the last page to revise the definition of matrix multiplication)

Write Matlab commands that will create the following matrices

B2 By el

>> a =
>> D =
>> C S o
>> X =

Now try to find (if the answer exists check that it is correct by hand)

>> b+c

>> b-2*c
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Matlab also does matrix multiplication (provided that the matrices can be
multiplied consistently).

e First calculate b*a by hand (see appendix at end of notes for details)
3 4|, |1 2 3
*a *
" a_{o 1} {4 5 6}
Now check that Matlab gives the same answer

>> o Kot L

e First calculate b*x by hand (see appendix at end of notes for details)

oo i

Now check that Matlab gives the same answer
>> D*X
Now check that Matlab gives the same results for b3 and b*b*b (you don't need to
do these by hand)
>> DD D e
>> DS e
Does the product a*b make sense ?

>> a*b

More complicated algebraic expressions like b + ¢ — (b"2)*c can also be found.
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7 The dot symbol

The dot symbol is special to Matlab — it is not a standard mathematical notation and
should not be confused with the dot product of two vectors.

It changes the meaning of *, /and ” in a very important way.
a”2 Ifaisasquare matrix then a2 means a*a —
It is the matrix product of a with itself (provided that the product makes

sense)

a2  Buta.”2 squares each element in a separately.
Even if a is not square (so that a*a is not defined) we can still define a.”2

a”2 and a2 are usually quite different
3 4
Example 1  Suppose that c= > 1
Because c is a 2 x 2 matrix we can calculate ¢? =c*c

. 17 16
Do the calculation yourself and check that you get ¢ = { }

8 9
Now see what Matlab gives for ¢"2 and c¢.*2

>> cN2
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1 2 3
E le2 Weh fi =
xample e have defined a {4 5 6}

Can we multiply a*a as a regular matrix product ?

Predict the values of a.*2 and check that you are right using Matlab

Now see what Matlab gives if you try to calculate a*a

>> a*a

Example 3  Supposethat b=[1,2,-1]anda=[1, 2, 3] and c=[1,2]

Try the following Matlab commands and make sure that you understand the answers
>> b= ... [defineb]
>>  1./b

What has this calculated ?

Try the commands
>> S [0 (=) i [ =N |
>> AFD
Do you understand how this was found ?
Try the commands
>> (O o 11191 |

>> a.*c

What happened here ?

What does this message mean ?
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Example 4  Using the dot command to evaluate functions

. If x =10, 1, 2, 3] what command would you use to square the entries in x
>>

. What Matlab command would you use to get the values of y = x*—6x+5 at
0,1,2and 3 ?

>> e

Example 5  This example is more involved as it uses several dots

First calculate the values of y = ZL for x =0,1,2and 3
(x“+1)
X 0 1 2 3
_ X
(x2+1)

Now check the following Matlab command and make sure that it gives the same
answers
>> y = XJ(x"N2+1)

D s

Notice that there are two dots here — one goes with the division sign and the one goes
with the power symbol (*).  You do not need to put a dot with the + sign
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8 The real power of Matlab - solving linear equations in one step

Suppose that you want to solve the equations

y+2z =1

X+2y+ z =3

3X+5y+2z =7
2| X 1
In matrix formthisis |1 2 1|y|=|3
2|z 7

In Matlab you can solve these equations in three steps.

We write this in the symbolic form A.x = b [here vectors are written in bold letters]
A is the 3x3 coefficient matrix and b is the 3 row x 1 column vector on the RHS.

Step 1 Define the matrix A - fill in the definition

>  A=[012;,121; 3572]

Step 2 Define column vector b

>> b=11; 3; 7]

Step 3 Solve for x using the backslash command

>> x = A\b

(notice that we do not have to define a symbolic vector containing the x, y, z
symbols. the variable x is the column vector containing the numerical solutions to the
equations)

Matlab returns the value X = -2.0000
3.0000
-1.0000

Warning: Be careful to get the order and the direction of the slash correct.
b\A or A/b will be quite different
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Step 4 Check that this is really a solution by calculating the difference between
the two sides of the equation — this is A*x - b

>> A*xX -Db

Matlab returns the value ans =

Practice the use of the backslash command

Use the \ command to solve the following two equations and check that the Matlab
solution is correct.

>> A=

>> D =
Check that x really is a solution by calculating A*x

>> A X e r e

o [z 2L

First write these equations out in detail — do they have a solution.

Then set up A and b in Matlab and see what you get.

>> A S
>> o IR

This set of equations does not have a solution and Matlab gives you a warning.
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9 Plotting 2D graphs

One very useful feature of Matlab is its ability to plot graphs of functions quickly.
This often uses the linspace command and the dot notation. For example suppose

that we want to plot the graphs of y= x2 between 0 and 5.

Step 1: Create a vector of 100 evenly spaced points between 0 & 5
>> x = linspace( 0, 5, 100);

The semicolon (;) is used to stop Matlab printing all 100 numbers out. If
you really want to check that the command worked use Data Editor to see
what is in x now. | choose 100 to give a large number of points. You could
have chosen any large number.

Step 2 Compute the y values for the curve y= X2

>> Yy =X"2;

[the dot here is very important - it squares the elements of x one at a time]

Step 3 Now plot just graphof y= X2
>> plot(x,y); grid; shg
Here | put three commands on the one line — grid puts dotted lines on the
graph to make it easier to interpret. The shg command means ‘show

graph’.

25

20

1%

10

You should see a graph drawn in blue [the default colour].
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Quiestion: What happens to the graph if you use 10 points instead of 100 ?

. Adding titles and labels to a graph

You can add labels to the x and y axes and also put a title on the graph as shown
below. You do not have to add labels or titles to graphs but if you are generating a
graph to paste in a Word document then labels and/or title are very useful.

The following graph was generated by the commands

>> plot(x, y); grid

>> xlabel(* x values’ )

>> ylabel(* y values’ )

>> title( * Plotof y =x"2")

Plot of y =%
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9.1 Putting several graphs of the one plot

Suppose that | want to compare the graphs of y=X, y=x2 and y:x3 over the
interval from -2 to +2.

We need to set up the x array (fill this in yourself)
>>

Next we need to calculate the coordinates on these three graphs
>> yl=x;

>> y2 = X2,

An extended version of plot can take more pairs of X, y arrays.
Each x, y pair is added to the graph

>> plot( x, y1, X, y2, X, y3); grid; shg [try this yourself]
Add in the grid and the shg command as well

Matlab uses a default colour scheme that usually plots them using colours in the
order blue first, then green and then red.

You can control the colour scheme yourself — e.g. the following command makes the
graphs blue, black and green

>> plot(x, y1, ‘b’, Xx,y2, ‘k’, X, y3, ‘g’); grid; shg [try this yourself]
You can change the colours or the style of the three plots yourself by adding a third
‘style parameter to any (or all) of the x, y pairs.

This is typical of Matlab — to make plots you have to give the x & y data and then
there are optional things that you do the plot.
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9.2 You can change the colour and style of the different lines in the
graph

Style refers to the way that the curve appears — a solid line, a dotted line, a line made
up of circles etc and/or to the colour of the curve.

The complete list of style options is

Various line types, plot symbols and colors may be obtained with
PLOT(X,Y,S) where Sis a 1, 2 or 3 character string made from
the following characters:

The left column gives the colour options, the right column the options
for the way the line looks.

y yellow . point

m  magenta 0 circle

C cyan X X-mark

r red + plus

g green - solid

b blue *  star

w  white :  dotted

k black -. dashdot

-- dashed

Examples
>> plot( x,y, ’b’) plots the graph in blue as a solid line (default)
>> plot( x, y, ’bo’) plots graph as blue circles
>> plot( x,y, ’g:") graph appears as a dotted green line.

>> plot(x, y1,’k’, X, y2,”:b’) first curve is a black line; second is blue dots

Warning
When you come to plot a graph on a black & white printer the lighter colours are

very faint. A good rule with graphs to use different styles sparingly and just enough
to clearly separate different curves.
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Exercise
Go back to your plot of y = x, y = x* and y = x°.
>> plot(x, y1,x, y2, X, y3)

Modify this command and add others so that you get a graph of these three curves
with

e y=xadotted black line
e y=x* ablue dot dash line
e y=x°isagreen dotted line
e add a grid to this graph
e add a title just below the x axis that says
‘Comparing y = x (solid), y = x"2 (.-) and y = X3 (..) graphs’
We can also adjust the size of the graph, the axes and put labels on the axes as well.

You can also control various features of a graph by using the Edit menu and
selecting the Figure Properties option - you can try experimenting yourself.
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9.3 Printing

Matlab graphs:

Matlab displays graphs with a graph background but if you want to put the graph in a
report it is better to change the background to white. The easiest way to do this is
use the Figure Editor.

Go to the last figure that you plotted and open the Figure Editor.

Fi Property Editor

| Edit Properties for
svie | info |

Menu bar.

Window name:

- Figure

[T

Iﬂgure:'l

=] ¥ 9|

Color: J10.200 0.800 0.800 ]

- |Cust0m cnlar...l

: IDefauItﬂgure menu itermns {figure)

[

Figure number: W Show
Renderer mode: M Auto Painters LI
Backing store: W LUsze
Double buffering: W Use
oo |[_som

W Immediate apply

Click here and select the white
" background colour for this graph
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9.4 Putting several graphs side by side.

Sometimes we need to put two graphs close together — like the ones below

Graph of y = sin(x)

The Matlab code to do this is

>>

>>

>>

>>

>

\%

Graph of y = cos(x)

x = linspace(-5, 5, 500); y1 =sin(x); y2 = cos(x);

subplot(1, 2,1); plot( x, yl1); grid; shg

title(* The graph of y =sin(x) *);

subplot(l, 2, 2); plot(x, y2); grid ; shg

title(* The graph of y = cos(x) *);

The subplot command is used to put the graph in the correct place - the
number 1, 2, 1 is interpreted as:

1 = number of rows in plot
2 = number of columns in plot (there are 2 graphs across the page)

The last number tells you where the plot goes as shown below.

subplot{121)

subplot{122)
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e Another way that is sometimes used is to put 4 graphs in a 2 x 2 pattern.

Graph of y = sin(x) Graph of y = cos(x)
1
1
|
0.5 -\-—-—-———- N
1
ob---Nooo 4 _\___|
|
|
05F--—-\--——- R EEEE T
1
-1 |
-5 0 5

The code for this is
>> x = linspace(-5, 5, 500);
>> y1l =sin(x); y2 =cos(x); y3 =sin(2*x); y4 = cos(2*x);
>> subplot(2,2,1)
>> subplot( 2, 2,2)
>> subplot( 2, 2, 3)
>> subplot( 2, 2,4)

plot( x,yl); grid; shg
plot( x,y2); grid ; shg
plot( x,y3); grid ; shg
plot( x,y4); grid; shg

The layout of the plots is

subplot{(221) subplot{222)

suhplot(223) suhplot(224)
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9.5 Using Matlab graphics to investigate a function

This section shows how Matlab graphs can be used to investigate an example of
solving an nonlinear equation. This is not the only way to do this — Matlab in fact
has a fast numerical method that will do this without needing to graph the problem.

Problem Investigate the solutions of the equation y = e X —sin(x) = 0

You can plot the graph of this function between 0 and 10 using
>> x = linspace( 0, 10, 1000 );

>> y = exp(-x) — sin(x); plot( x,y) ; grid; shg

) Figure No. 1 H=] E3

File Edit “iew Insert Taools ‘Window Help
lDzmga a2z @es

expl--sinx)

- — — 4]
S
1
1
1
1
1
- - -1
1
1
1
1
- - =

=
iy}

[

1

1

1

1

1

1

1

1

e m —— = — —
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Jry
T
1
1
1
1
1
1
1
1
1
|
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

i S NS R

O
JC
-
L -
i
O o ) .
o -
-
[
—
O

B  «——  Click on plus magifying glass to he

able to zoom in with the mouse

HOW TO MAGNIFY PARTS OF THE GRAPH

e Click on the magnifying glass symbol at the top of the graph to let you zoom in
to parts of the graph.

e Choose the part of the graph that you want to magnify by holding the mouse
button down and draw a small box around the 'zoom region' . Release the mouse
button to see the zoomed region.

e Double click zooms back out to the original graph.
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Approximately solving the nonlinear equation e™* —sin(x) =0 using this
graph.

The places where e * —sin(x) =0 are where the graph of y=e"* —sin(x)

crosses the x axis.

You can zoom in on the points where y is small and get quite accurate estimates
of the solutions. It is possible to zoom in so that you can find a solution to 1 or 2
decimal places - try this method out to

e find the solution ClOSESt 10 ZErO  ...vvn e e e,
e find the 2" solution ?

o findthe 3™ SOIUtION 2 ooovveieeee e
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10 Matlab is designed to work easily with vectors

With ordinary calculators you can usually only calculate the values of functions like
sin, cos etc at individual points. In Matlab you can get the values of sin at a whole
list of values in one step.

For example
>> SIN(L) e, [gets one value]
>> x=[3.0, 1.0, 75]; y=sin(x) [gets all 3 values]

This gives the array [ 0.1411,0.8415, 0.9380]

Here 0.8415 =sin(1), 0.1411 =sin(3) and 0.9380 = sin (7.5) - with all values taken
in radians.

How does Matlab do this ?

In most other languages (e.g. Pascal, C, Java) if you wanted to do this calculation
you would need to set up a loop to process the three entries individually. In Matlab
the loop is done for us because Matlab has been programmed so that its sine function
can process individual numbers and arrays.

When you type the Matlab command sin(x), Matlab first finds the size of the x
array. If x is a single number it calculates the sine of that number.
If x is an array or a matrix, Matlab will process each number in the array.

Because Matlab has this sophisticated ‘interpreter’ Matlab programs are typically
much sorter than programs in other languages.

Functions that can process a whole array

e Mathematical functions like sin, cos, log, exp, sqrt etc all accept vector input and
give vector output.

e There are some other functions that can process a whole array (or vector)

sum — this adds together all the entries in an array

max - finds the largest (maximum) number in an array
min — finds the smallest (minimum) number in an array
length — gives us the number of entries in the array

O O0OO0Oo
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Example 1  Experiment with sum(x), max(x), min(x) and length(x)
when x=[3,1,7.5].

>> 11101
>> T D) P
>> MUN(X) et e e e e e e e

>> length(X) .ovoree e,

Exercise2  Finding ° + 2° + 3 + .., + 171°

1. Construct b = [13 2 3 .. .. 10 113]

>> a =1:1:11;
>> p=an3;

2. Now add up the entries in b - this uses the sum function

>> sum(b)

. . . .2 .11
Exercise 3 - Calculate s = sin(0) + sm(%) + sm(?”) + .t sm(Tﬂ)

11
This can also be writtenas s = ZSin(%k)
k=0

e  Find the shortest way to set up the vector k = [0, 1, 2, ........ , 11]
D>
o get b= {O, 1, 2—” 3—7[ 4—” ........ , 1—} from k
6 6 6 6
>> D= e,
e Find c= { sin(0), sin(%), sin(%”), ....... sint) }
>> T e e

>> s =
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e The exact answer for this sum is zero but you might not get this because of
‘round off’.

Write the answer that you get in scientific form ( like 2.45x107° )

Example 4  Use the same idea to calculate the following sum

T 27 3T A S5r
¢ = cos(0) + cos(—) + cos(—) + cos(—) + cos(—) + cos(—
(0) (4) (4) (4) (4) (4)
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11 Symbolic algebra and calculus exercises within Matlab

Matlab was originally only a numerical program but it has linked up with the
symbolic algebra package Maple to include some parts of Maple.

Symbolic algebra packages do algebra and calculus symbolically.

They can handle mathematical formulas like (x+ y)® and expand or simplify them
because the rules of algebra are programmed into the package. They can also do
basic calculus because the rules of differentiation and some techniques for
integration are also programmed into them.

Symbolic algebra packages are helpful for many purposes but they do not always

give us the simplest answer. Maple and Mathematica are examples of more powerful
symbolic algebra packages.

11.1 Basic symbolic algebra

. Declaring symbolic variables

To do symbolic algebra in Matlab we need to tell Matlab that we are dealing
with symbolic variables

Try out the following commands
>> syms X y < xandy are defined as symbolic variables

>> whos & check to see what variables are defined
>> f=x"2 -5*-3 <& defineanew expression f =x*-5x-3

>> pretty(f) < tries to print it in a more conventional form

Note:  Symbolic variables like x and f are quite different from arrays. The dot
notation is never used with symbolic variables.
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e Expand the expression g =(x*-5*x-3)°

>> g = expand(f 3)

Will the Matlab simplify function convert g into its original form ?

>>  simplify(g)

The simplify function sometimes works and sometimes doesn’t —
. Simplifying trig expressions

>> f=cos(2*x) + 1

>> fe =expand(f)

>> fs = simplify(fe)

Exercise

Canyou get sin(x+ y).cos(x—Y) into a simpler form ?
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11.2 Basic symbolic calculus with Matlab
This shows you how to get the derivative and integral of a function f(x)
e Getting the first derivative of f =x*-5*x-3

>>  df = diff( f, x)

You should be able to check that this is correct and to find the type of df

. Integration

Matlab can also do symbolic integration for many functions. Let’s do a simple
example that you know how to do without Matlab

What is the indefinite integral of f =x*+ 1 ?
X

Check your answer with Matlab

>> intf =int(f, x)

If need be use pretty(intf) to put in a nicer form
You should find that your answers agree.

. Definite integrals

5
Mostly we need to work out definite integrals like j(xz +£).dx
X
2
We use an extended version of int that allows us to include the limits on the
integral.

>> int(f, x 2, 5)

e In this case use whos to see what type of object this calculation produced —
was it a real number or a symbolic object.
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11.3 Solving simple differential equations symbolically

Matlab can also solve some differential equations symbolically. The command is
called dsolve. It will not work for every differential equation but is worth trying.

Example Find the general solution of % =y

>> soln = dsolve('Dy=y",'t") < ‘Dy =y’ sets up the DE
‘t” is the independent variable

soln = Cl*exp(t) €& soln = C¢'

Example Find the general solution of % = y which startswithy =2 att=0

>> soln = dsolve('Dy=y", * y(0) =2, 't") < ‘y(0)=2 sets up the
initial condition

soln = 2*exp(t) & soln = 2¢
You can use the command  >> help dsolve to learn more about dsolve.
Warning:
Symbolic packages are limited. Sometimes they will not be able to find any solution

and other times they will give you an answer that will involve unusual or unfamiliar
functions.
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12 Some easy graphics commands in 2D and 3D

The easy plot commands all start with ez.

12.1 The 2D ezplot command
To plot the function y =sin(x) between x =0 and x = 3.

>> ezplot(‘ sin(x)", [0, 3]) (define function and the x range of the plot)
Advantage: Easy to use
Disadvantages
(1) it does not give you any control over how many x, y points are plotted in the
graph — it always uses 300 x points. Usually this is enough but sometimes
we definitely need more points
(i1) ezplot only handles one function at a time.
e ezplot can also graph "implicitly defined functions’

These are graphs that are defined by a formula f(X,y)=0.

A simple example is the circle with radius 1.
It has the implicit formula X2 + y2 =1

This is better writtenas X2 + y2 -1=0

The command that plots this is

>> ezplot("x"2 + y"2 -1, [-3, 3])

Implicit functions can give very interesting shapes.
Here are other examples

. X4 _x2xy2 4 yA 120
. X —6*x2*y2 1yt _1=0
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12.2 3D graphics using ezsurf

The most common type of 3D graphics is to plot a surface.

Surfaces are described by an equation z = f (X, y). Ateach point in the xy plane we
calculate z from the formula z = f (x, y) and this gives the height of the surface.
Here are some examples of surfaces

Example 1: z=x*-3y*+1

Plot the shape of the surface over the range of x values from -4 to +4 and y
values from -4 to +4

-3y +1

0
n Ty 4
AR g

VL LA W
A
e
A A

T s T SN
1:‘“ lt‘ﬂ- i

Lo AT

i CUAAIAAY W,

"!..'I-\\‘:h&\hwmﬂ&{&&“ﬁ )
ALY

Here are commands that will plot this surface

>> ezsurf( * x~2-3*y"2+1°, [ -4, 4,-4,41]); shg
>> colorbar

The four numbers in the array are
[minimum x value, maximum x value, minimum y value, maximum y value]

On the screen you will see a colour coded graph — the colour is related to the height
and it is very useful to add a colorbar on the side.
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12.3 Rotating a 3D plot

It is very helpful to be able to twist a 3D surface to see what it looks like from
different directions.

-} Figure No. 1 -0 x|

File Edit View Insert Tools ‘Window Help

B I A -

This is button to click to allow 3D rotations

Once you have clicked the rotation button you can ‘grab’ hold of the plot with the
mouse and rotate the picture to get the most informative view — best to rotate slowly.

12.4 Other types of plots in 2D and 3D

There are many other types of 2D and 3D plots in Matlab. To see some of them you
can use the demonstration programs

>> graf2d [shows you 2D plots]
>> graf2d2 [shows 3D plots]
>> demos [the full list of Matlab demos]
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13 Defining your own inline functions.

So we have used built-in functions like sin, cos etc.

However very often we need to define our own functions. There are several ways to

this. Inline functions are useful for functions that have a simple one line formula

Three functions that occur in science and engineering are

-x%/2

The normal distribution y = e
The chirp pulse y = sin(t?)
The sine function y = sin(t)

The sine function oscillates at a steady rate and so it has a constant frequency. The
chirp pulse oscillates more and more quickly and its frequency increases with time.

The normal curve is widely used in statistics and probability.

e e A m A==

-4 -2 1]
Plot of normal curve Plot of chirp signal

Plot of sin curve
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Defining these functions using inline definitions
Defining the formula for the normal curve

>>  f =inline( ‘ exp(-x."2/2) *, *X’);

Defining the formula for the chirp signal

>> g =inline(‘sin(t."~2)’, ‘t’);

An alternative definition of sin function

>> h = inline( ‘sin(x)’, ‘x’); [not really needed]
Calculating the value of an inline function
To get the value of the normal curve at x = 2

>>  f(2) [should get 0.1353]
Using an inline definition to plot a graph

To plot a graph of the normal curve between -5 and +5

>> x = linspace(-5,5,400);
>> y = f(x); [this works because f uses dot notation]
>> plot(x,y); grid; shg

Inline definitions have lots of other uses but once you leave Matlab your inline
definitions vanish. If you want a more permanent definition you need to create
an ‘m file’
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14 Script files functions

So far we have typed individual commands into Matlab. This can get tiring and if

we are going to be using the same set of commands several times it is useful to store

the commands in a single file.

Matlab will let you store commands in a script files. Then you can easily change

the commands without having to retype them all.

14.1 Creating and storing a script file to plot a function

e  First let’s open up the editor

Go to the File menu (top left)
Click on this and choose New and then M- file.

Then release the mouse button

4 MATLAB

File Edit Debug Desktop ‘Window Help

New

1

Open... Cir+0
Close Cormrmand Window

Irmport Data...

Save Workspace As.. Ciri+s
Set Path...

Preferences...

M-File
Figure
Yariable
Model
GUI

ctory: | CMatlah T eeork

i

1d Window

e The editor window now opens up - it looks like

%] Editor - Untitled

1

File Edit Text Cell Tools Debug Deskiop Window Help
D= iB2Ro | S éaf 08 O8BE B8 st

Now we just type Matlab commands in this window.

The line numbers on the left are used by error messages to tell you where

errors occur.
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e Creating a script file

Type the following commands into the Editor window

% first define the function to plot
f=inline( “ sin(x."2)’, “ x*);

% next set up x and y arrays
x = linspace( -3, 3, 500);
y = (x);

% plot the graph and add label
plot(x, y, ‘b’); grid; shg
xlabel(*Plot of sin(x2) between x =-3 and + 3’)

The lines that start with % are comment lines.
They are added to explain what the code is doing
These lines do not start with >>

e Saving this file

Go to the Edit menu and use the Save As option
Save this file under the name test.m

e Go back to the Command Window
Then run the script file get a graph like the

>> test

Plot of sin() between x= -3 and +3
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Seeing what happens if the script file contains an error
Go back to the editor and change the 2™ line to
x = limspace(-3, 3, 500);
Save the changed file and then run it from the command window.

You ought to get the following error messages

??? Undefined function or variable 'limspace’.

Error in ==> C:\MATLABG6p5p2\work\test.m
On line 5 ==> x = limspace( -3, 3, 500);

The first line tells you that Matlab does know a command called limspace
The second line tells you the file where the error occurs.
The last line tells you that the error occurs on line 5.
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14.2 Changing this script file

One advantage of this script file is that we can easily edit it to change any of the
following

e the definition of the function being plotted
e the limits on the x axis
e the title on the graph

Switch back to the editor window and change the script file so that it will plot the

X
raph of = between -10 and 10
grap y x* +1

You will need to change the definition of f to f=(X)./(x™M+1)
Also change the x array

Be careful to save your new script file before returning to the command window
You can use the Save option in the Edit menu.

If you run test again you should get a graph

os i i i i i i i i i
-10 -8 -B -4 -2 o 2 4 = g 10
Plot of :-:.-’{:-:4+1} between x = - 10 and + 10
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15 Using some built-in functions

You have seen some of the simpler built-in functions

e Basic Maths functions like sin, cos, exp, ..

e Functions that work on arrays like sum, max, min, ....
e Functions for plotting graphs like plot, ezplot, ...

There are many hundreds of other built-in functions that do more sophisticated
things.

One example of a useful built-in function is quad.
This is used to estimate the value of an integral numerically.

5 2
Example: Estimate the value of the integral J'
1

dx

e +1
It is not obvious how to do this by calculus so we estimate the integral numerically

There are two steps

1 Define the function f(x) = as an inline function using the dot

o

Notation
>> f =inline( *(x.”2)./(exp(X)+1)’, ‘X’)

2. Now use the quad function to work out the integral fromx=1tox =5
>>  res=quad(f,1,5)
This gives the answer as 1.4471

Learning more about what quad does.

The quad function has optional extras — for example, you can set the accuracy that

you want the answer calculated to (the default accuracy is 10°). To learn more

about the quad function you can use

>> help quad
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Appendix 1: Revising matrix multiplication.
2 3 4 3
If A_L 4} and B_{Z J then the product

A*B:{z 3}{4 3}:{2*44-3*2 2*3+3*1}

1 4|12 1| |1%4+4*2 1*3+4*1

Here each entry in AB is made by combining one row from A with one column from
B.

For example:

The (1,1) entry of A comes fromrow 1 of A = [2 3] - and column 1 of B :B}

This iscombinedas 2*4 +3*2 =8+ 6 = 14.

Carry through the rest of the calculation to check that
A*B :[2 3}{4 3}:{14 9}
1 412 1} (12 7
If you still need some practice try to calculate
2 3(,|2 3
A= A*A:L 4}{1 4}
Note:

Matrices A and B can only be multiplied if the number of columns of A = the
number of rows of B

If Aisa2 x 3 matrix and B is a 3 x 3 matrix which of the following products are
defined

(i) A*B (i) A% = A*A
(iii)y B2 (iv) B*A
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